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Remembering Those Who Paved the Way, Part II Reminiscences of the Past from the Anniversary 
Committee

    Hard to believe a year has passed and my Presidency is 
almost over. What I thought would be a tough year working on a board with all these Directors and 
Managers of libraries turned out to be very enjoyable. 
 My gratitude to all members of this 2004 – 2005 Board.  June Berger, Heidi Bliss, Patricia Kasting, 
Patricia Barbone, Karen Heusel, Janet Peros, Anthony Cocuzzi, Andrew Tschinkel, Mark Zaleck  All had a 
hand in helping me ease into and feel comfortable with the duties of being President of one of the larger 
library chapter organizations of AALL. 
 To be honest, after two tries to get to this position, I really want to slow the clock down and enjoy 
it a little more. But with a new Board and Heidi as President I know we can continue to work in making 
LLAGNY known not only as a chapter of AALL but also one that people recognize for great 
achievements. 
 My thanks to all committee chairs and volunteers.  Wilson Addo, Elizabeth Kenney, Bruce Bosso, 
Helen Lawless, Denis O’Connor, Kathryn McRae, Anthony Lovell,  John Lai, Christina Rattiner, John 
Campbell, Raul Lopez, Kim Council, Ralph Caizzo, John Davey, Brooke Raymond, Judy Dhanraj, Karen 
Provost,  Elaine Egan, Janet Accardo, Laird Ehlert. 

Thanks to Kathleen McLeod and Tom Eikenbrod for so many and diverse Educational Programs.  
To Sarah Valentine and Jeff Cohan on bringing back the MCLE Bridge the Gap Program. 
To Stanley Conrad and Ben Toby for the many enhancements to our website. 
To Karen Campbell and Sarah Kagen on the revised upcoming Union List. 
And special thanks to Marlene Gebauer and Jim Murphy on adding so many new features to our 

newsletter issues. 
 Thank you all for allowing me to have a part in the leadership of LLAGNY. 
I will always remember this as a Good, Personal, Unique and Special experience. 
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Lunch breaks during the 9/11 trial 
Linda Holmes, Brooklyn Law School Library 

 
It’s funny how things work out in life.  Sometime after the tragic events of September 11, 2001, I remembered 
reading in the New York Times that there would be a lawsuit involving the insurance for the World Trade Center to 
determine whether it was one event or two and what the insurance payout would be.  I thought to myself that that 
would be a very interesting trial and anticipated hearing about the final outcome.  Never in a million years did I 
think I would have any involvement with the verdict in that case or any other issues relating to September 11th. 
 
But there I was on the morning of February 4, 2004 at the Southern District courthouse ready for jury selection 
with 200 other people. By the end of the day I was one of the chosen twelve for Swiss Re International Business 
Insurance Co. v. World Trade Center Properties LLC. Judge Mukasey told us the trial would last eight weeks (it actually 
took two and one-half months for the trial plus two weeks of deliberation); and with an hour and a half for lunch 
every day, I began to think that at the very least, I could explore some of the many interesting museums that are 
located in lower Manhattan, from the National Museum of the American Indian to the New York City Police 
Museum. (continued on p.7) 
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John Davey: LLAGNY Profile 
 

Is it true your parents were married on a game show?   
Yes, they were married on a program in the 1950’s called “Bride and Groom”.   My mother 
got to choose her gown out of a room filled with thousands of gowns.  They were given a 
washer, dryer, silverware, etc. and a honeymoon in Lake Placid.  My Mom was mad because 
the couple from the previous day was sent to Hawaii.  Most people in Smyrna, Georgia (my 
Mother’s hometown) and Matamoras, Pennsylvania (my Dad’s hometown) watched the 
program at their respective local TV store because most people didn’t own a TV at that 
time.   
 
Have you ever had to sing for your supper?   
Yes, most prominently at the CCH dinners they used to have at the AALL Conventions.  I 
did that for about 3-4 years in a row.  It started out as an after dinner fluke because I had 
drank too much and somehow it turned into a yearly event.   
 
What is your favorite/least favorite part of your job?   
I think that the truly fun part of librarianship is finding out the answer to something.  There’s nothing like trying to find that 
“needle in a haystack” answer for something that no one has a clue how to locate.  Sometimes, you can’t find it, but when you 
do, it makes your whole day, week or even month.  My least favorite part of any job is getting to work in the morning.  I am 

not a morning person. 
 
How have you seen librarians roles change over the years? 
I see that a lot of emphasis has been put on the virtual library and 
finding everything “on line”.  Granted, that is most preferable, but now 
that I work at Sullivan & Cromwell, it reminds me that both print and 
electronic versions are necessary for effective research.  They have a 
great archive at S&C.  They never throw out anything.     
 
How has the library community aided/supported you in 
your career?   
Networking through friends that you meet at AALL Conventions and 
LLAGNY functions has kept me alive in the community for 20+ years.  

The people that I have met at the Conventions have truly assisted me when I needed something out of state.  I will never 
forget my first convention in Seattle and the day after I returned, someone needed a Seattle ordinance.  So I called a librarian 
from there that I had met at the convention and they faxed it to me immediately.  The attorney was amazed.  
 
What did you want to be when you grew up?   
I wanted to be Gene Kelly!!! 
 
Can you tell us about the history of your home? 
Well, I have a weekend home in Kingston, NY about 2 hours north of Manhattan.  It is a late Victorian built in 1896.  It has 
hard wood floors, pocket doors, high ceilings, built-in cabinets, original hardware, a majestic staircase with lead glass windows 
from the landing to the ceiling, and beautiful carved gingerbread work looking from the staircase into the library.  I have been 
restoring it with Victorian wallpapers and fabrics as well as all authentic Victorian furniture.  I just had it placed on the 
National Register for Historic Places last year.  I am planning for my retirement there!!!! 
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CURRENT BROADWAY MUSICALS 
 

 
answers can be found on page 10 

Across 
1.    One of five in NYC. 
5.    Puppet love. 
7.    Roar! 
8.    The city where “he had it coming”. 
9.    Two men in search of a flop. 
10.  Fellini’s Nights of Cambria - but in New York. 
12.  Where’s that Holy Grail anyway? 
14. “There’s got to be a morning after….”  ‘s songbird is Marmie in this show. 
Down 
1.   French fairy tale a la Disney. 
2.   They are what they are? 
3.   Twyla won her Tony. 
4.   Surfer boys on the Great White Way. 
6.   Bruce Vilanch shaved his beard for this! 
11. It’s not easy being green. 
13. What the landlord gets. 
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Holmes, Continued from page 3 
 
Castle Clinton National Monument was built as a fort to 
defend New York harbor during the War of 1812.  Castle 
Clinton served as an immigration center before Ellis Island 
opened.  Located in Battery Park, it has also been used as an  
aquarium, a public pleasure garden and an opera house where 
P.T. Barnum presented the 1850 debut of the Swedish 
Nightingale, Jenny Lind. 
 
Today it is has been restored as a national monument and 
includes exhibits on the history of Castle Clinton and other 
National Parks Service sites.  Tickets for the Statue of Liberty 
and Ellis Island may be purchased at Castle Clinton. Just 
outside the entrance I was surprised to find a battered survivor 
of 9/11- the sculpture that had stood in the center of the 
World Trade Center Plaza. 
 

Castle Clinton 

 

    
WTC Memorial Sculpture     Museum of American Financial History Gift Shop 
 
The Museum of American Financial History, an affiliate of the Smithsonian Institution, showcases the history 
of Wall Street and the businessmen and women who worked there. It is currently located at 28 Broadway, for many 



 ♦   

  

8

 

years the headquarters of John D. Rockefeller’s Standard Oil Company. The charming manager of the museum 
shop, Rita Fabris, told me that the museum might be moving to Wall Street soon. Her shop is full of strange and 
interesting gifts related to money. 
 

The current exhibit, “Still They Ride: the Original Dow Dozen,” highlights the histories of the twelve companies 
that comprised the original Dow Jones Industrial Average in 1896, the evolution of the Dow and biographies of 
Charles Dow and Edward Jones. 
 

The National Museum of the American Indian, a unit of the Smithsonian Institution, is located in the historic 
Alexander Hamilton U.S. Custom 
House on historic Bowling Green 
at the bottom tip of Manhattan. It 
is dedicated to the preservation, 
study and exhibition of the life, 
languages, literature, history and art 
of the First Peoples. There is a real 
contrast between the building itself, 
a Belle Époque masterpiece with an 
enormous oval rotunda with WPA 
commissioned murals by Reginald 
Marsh, and the small collection of 
Indian artifacts dating back to the  
pre-Columbian era. 
 
Currently on display is “First 

American Art,” the Charles and Valerie Diker Collection of American Indian Art, which includes clothing, tools, 
objects and artifacts the couple collected over the years. 

 

The New York City Fire Museum is housed in a 
handsome renovated 1904 firehouse and contains an 
extensive collection of fire service memorabilia.  
Here you can view the evolution of fire fighting 
equipment and vehicles from the bucket brigades to 
horse drawn steamers to a vintage 1950 fire truck. 
 
On display are Fire Department uniforms, medals, 
fire insurance marks and newspaper stories on great 
fires.  A room in the museum is dedicated to 
September 11th and includes pictures of the members 
of the department who were lost on that day. 
 
This museum is fortunate to have members of the 
department who serve as guides and are happy to 
share their knowledge of New York City fire fighting 
with visitors. (continued on page 11) 
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Factiva Jumps from Westlaw to Lexis 
Westlaw adds NewsRoom content. 

Lexis And Westlaw Announce Content Changes To NY Law Librarians. 
Patricia Barbone, Hughes Hubbard & Reed LLP 

 
In February and March, both LexisNexis and 
Westlaw held special programs for local law 
librarians to help explain the content changes 
involved in each of their services for news related 
resources.  Lexis is now partnering with Factiva, 
and Westlaw no longer offers Factiva but has 
integrated other Thomson content such as Dialog 
NewsRoom into Westlaw. 

In an attempt to reach the broadest number of 
New York City librarians, both vendors held two 
programs each at both a midtown and downtown 
location.  Westlaw got the first shot in February 
with a lunch at New York County Lawyers on 
Feb. 15th  and a breakfast at their midtown offices 
on Feb. 16th.   LexisNexis followed in March with 
a lunch at the Yale Club on Mar. 2nd, and a 
breakfast held downtown on Mar. 3rd at the 
Millennium Hilton Hotel. Since the majority of 
changes occurred on March 1st, these programs 
were well attended. 

The most significant change for Westlaw users 
was the removal of the full text of the Wall Street 
Journal.   Other changes involved new search 
functionalities and a change in the publication 
coverage.  Some of the new functionalities are: 
Westlaw’s smart terms for precision searching, the 
addition of ‘Results plus’ features in the news 
databases, the ability to remove duplicate articles, 
and the addition of legal and public records 
materials to news content.  Their were coverage 
and availability changes to some of the major 
newspapers which were potentially problematic.  
These include the Chicago Tribune, LA Times, 
Orlando Sentinel, and Washington Post.  At the time 
of the program, the coverage and availability was 
not confirmed.  Although Westlaw now has the 
New York Times, they will only be offering 
abstracts of the Wall Street Journal.  Westlaw may 
be able to license more publications and plan to 
bring as much Thomson provided material as 

possible, but at the time of the program, many 
negotiations were still not finalized.  Westlaw 
searchers who need absolutes about searching 
specific publication titles will need to check the 
scope and coverage before doing a search, or look 
to other resources to fill in the gap. 

Finally, Westlaw offered attendees a sneak 
preview of Practice Builder, a competitive product 
to Lexis’s ‘Dossier’ or ‘Company Analyzer,’ 
designed to help law firms prepare information in 
a format that is targeted, customized, and 
actionable.  Practice Builder will be released later 
this year.  This product generated some 
excitement, but attendees also wondered about 
the potential cost, which was not discussed. 

The LexisNexis program discussed the new 
partnership with Factiva.  This announcement 
generated more emotion from the audience than 
did the Westlaw announcements.  The most 
welcomed news was the addition of the Wall Street 
Journal and other Dow Jones publications, which 
for so long had been only available on Westlaw or 
through Dow Jones directly.  Although librarians 
were mainly happy to have the addition of the 
Factiva resources to LexisNexis, the costs and 
content overlap with existing Nexis libraries was 
not satisfactory to many of their customers..  In 
order to bring the Factiva content to their 
platform, LexisNexis created several new libraries 
with Factiva content.  The libraries were offered 
to all LexisNexis users on a per search basis.  
Therefore, even if you have a flat rate contract, 
which included Nexis materials, the Factiva 
databases were considered an “excluded” item.  
Nexis and Factiva content overlap in many areas, 
and many users felt they had already paid for the 
much of the content when doing a Nexis search.  
Unfortunately LexisNexis strategic thinkers back 
in Dayton did not create a Factiva exclusive 
library so that you could pick up the resources 
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unique to Factiva to complement rather than 
duplicate your Nexis search.   

Libraries that had a subscription directly with 
Factiva were also reminded that they would not 
be able to continue their subscriptions beyond 
March of 2006, and that Factiva would not deal 
directly with any library in the legal market.  That 
probably wouldn’t be so bad if the costs to 
subscribe to Factiva via LexisNexis weren’t so 
much more than what libraries were presently 
paying Factiva.  Some audience members 
speculated that the costs would increase three to 
fivefold per month.  

Although Factiva content was integrated into 
Nexis, there was no discussion of when the 
Factiva search functionalities, called “intelligent 
indexing,” would be available on LexisNexis.  As 
news content expands, the ability to navigate 
through mega databases becomes more difficult.  
The features available on the Factiva platform, 
like their event codes and drop down menus, 
which limit content type, are helpful for 
narrowing searches.  When “intelligent indexing” 
arrives on LexisNexis, it should enhance their 
already powerful search capabilities. 

Librarians who were the most upset about the 
changes to both Westlaw and Lexis were the 
Westlaw users who used Westclips to generate 
Factiva news emails; and the Factiva users who 
used Factiva for email watches.  Those customers 
are being forced into making quick decisions in 

order to prevent coverage lapses and disruptions 
to the current awareness services they provide 
through their libraries.  Those users who relied on 
Westlaw for Factiva alerts were in the most 
difficult situation.  These users have to decide 
whether or not to move their watches to 
LexisNexis, and they have to decide in a hurry.  
More questions were raised than were answered.  
Should they plan to move their watches to 
LexisNexis to incorporate Factiva’s content?  If 
so, should they try to negotiate with LexisNexis to 
add it to their monthly commitment or should 
they pay for it on a per search basis?  Current 
Factiva users who do their watches on the Factiva 
platform have a little more time to decide…and 
negotiate.  In any case, for these users, the 
changes are dramatic.  No one likes to make 
choices while backed into a corner, when it seems 
that there really is no choice at all. 

What will be the final outcome of the changes to the 
news coverage for Westlaw and LexisNexis? Will the 
loss of Factiva be significant to Westlaw or will the 
Dialog NewsRoom coverage make it negligible?  And 
as far as LexisNexis goes, what will be the fallout for 
they way they have marketed and priced the Factiva 
coverage?  Will libraries sign up for Factiva content or 
hold out for reasonable pricing?  All of these 
questions will play out over the next few months on 
listservs; at meetings; on the telephone; and in private 
emails, as we grapple to provide an optimal mix of 
news content for our organizations.

 
Answers to the Current Broadway Musicals Crossword from Page 6 
 
Across 
1. Brooklyn  
5. Avenue Q 
7. The Lion King 
8. Chicago 
9. The Producers 
10. Sweet Charity 
12. Spamalot 
14. Little Women 

Down 
1. Beauty and the Beast 
2. La Cage aux Folles 
3. Movin Out 
4. Good Vibrations 
6. Hairspray 
11. Wicked 
13. Rent
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Holmes, Continued from page 9 
 
Eddie Fusco was a particularly informative and enthusiastic guide. He pointed out that the most elaborate and 
costly of the 19th century firewagons were built not to fight fires but to impress during the many municipal parades. 
Remember the parade scene from Hello Dolly ?  
 
The New York City Police Museum is housed in an impressive four story building, modeled after an Italian 

palace, which once served as the first precinct police 
station and, much later, as the home of the Office of 
Landmarks Preservation. It stands somewhat isolated 
amidst modern skyscrapers near the South Street 
Seaport. 
 
The three floors of displays include uniforms, vehicles 
and firearms of the department.  The second floor has 
sections on notorious criminals, vintage weapons, and 
there is even a jail cell you can lock yourself into for a 
taste of incarceration! 
 
The moving “Hall of Heroes” is located on the third 
floor.  The walls of this room contain the shields of 
police officers killed in the line of duty since the 
creation of the department in 1845.  As you walk 
through the room and view the shields, an audio roll 
call of the names of those officers who have been so 
tragically killed is played.  This floor also includes an 
equally touching multi-media exhibit which chronicles 
the response of the New York City Police Department 
on September 11th. 

 
St. Paul’s Chapel, built in 1766, is Manhattan’s oldest 
public building in continuous use.  It is the classic early 
American church. George Washington used to worship 
there when New York was the nation’s capital.  Located 
opposite the World Trade Center site, it was used as a 
relief location for volunteers for eight months after 
September 11th and continues to offer musical solace to 
visitors today with its “Concerts at One” series.  These are 
free concerts offered every Monday afternoon at 1pm, and 
an interactive exhibit, “Unwavering Spirit: Hope & 
Healing at Ground Zero,” is on display to honor those 
people who volunteered and found relief at St. Paul’s after 
9/11. 
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MEMBERSHIP NEWS & MOVES 
Margaret Bennett is President of Pro Libra 
Associates, Inc. in Maplewood, NJ 
 
Ellen Brondfield is Director of Library & 
Information Services at Steptoe & Johnson, 
Washington, D.C. 
 
Sarah Browne is Chief of Law Library Services 
at the NYS Office of the Attorney General in 
Albany 
 
John C. Campbell is Information Services 
Manager at Nixon Peabody LLP 
 
Angela C. Dzikowski is CPC at Pro Libra 
Associates, Inc. in Maplewood, NJ 
 
Anthony O. Fagbore is Librarian Assistant at 
Dorsey & Whitney LLP 
 
Elizabeth Florez is Library Acquisitions 
Specialist at Thacher Proffitt & Wood LLP 
 
John T. Foster is Librarian at Ford Marrin 
Esposito Witmeyer & Gleser, LLP 
 
James Hannigan is an Analyst with 
Bloomberg LP 
 
Barbara M. Hirsh is Director of Nera Economic 
Consulting in White Plains, NY 
 
Carol Jarema (formerly with Swidler 
Berlin/Shereff Friedman) is now Librarian at 
Dechert LLP 
 
Marion E. Johnson is a library student 
 
Daniel P. Jordan, esq. 
 
Stephen T. Kochoff is Regional Sales 
Manager for Basch Subscriptions 
 

Katherine A. Mitchell is a library student 
 
Trina L. Morrow is Reference Librarian at 
Willkie Farr & Gallagher 
 
Rebecca Newton is a Paralegal at Manatt 
Phelps Phillips LLP 
 
Nuchine Nobari (formerly with Wilmer Cutler & 
Pickering) is Director of Library Services at the 
New York County Lawyers' Association 
 
Karen Oesterle is Senior Print Specialist at 
Matthew Bender/Michie/Mealey's within 
LexisNexis 
 
Elina Oyola is Library Assistant at New York 
Law School 
 
Connie S. Pine is Director of Library Services 
at Bracewell & Giuliani LLP in Houston, TX 
 
April L. Schwartz is Director of Touro College, 
Jacob D. Fuchsberg Law Center Library 
 
Laura Sheer is Head Librarian at Swidler 
Berlin LLP 
 
Steven B. Simpson is Reference Librarian at 
Latham & Watkins 
 
Ken Stern is Executive Account Manager at 
Global Securities Information 
 
Teekachand Tiwari is Senior Account 
Executive at Critical Mention 
 
Sybil Ward is Assistant Librarian at Dechert 
LLP 
   
Constantine Cannon, P.C. and is now 
located at 450 Lexington Avenue, 17th floor, 
New York, NY 10017 
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Holmes, Continued from page 11 
 
On the day of jury selection for the World Trade Center case, the clerk asked each person as they turned in their 
jury questionnaire if they were “ready to serve,” and all but a few potential jurors said yes.   After I completed my 
three months of service, several people asked me if I found jury duty “burdensome.”  I can truly say that it was an 
honor to serve; not burdensome in the least, and as a resourceful librarian, I even found ways to learn more about 
the museums of New York City during my lunch breaks! 
◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙◙ 
Days and hours of opening and travel directions are readily available by logging onto the web site of the 
Lower Manhattan Development Corporation at:  www.renewnyc.org/Heritage or the museums’ web sites 
below: 
 
Castle Clinton National Monument 
Located in Battery Park 
212-344-7220 
www.nps.gov/cacl 
 
Museum of American Financial History 
28 Broadway 
212-908-4110 
www.financialhistory.org 
 
National Museum of the American Indian, 
Smithsonian Institution 
One Bowling Green 
212-514-3700 
www.americanindian.si.edu 

 
New York City Fire Museum 
278 Spring Street 
212-691-1303 
www.nycfiremuseum.org 
 
New York City Police Museum 
100 Old Slip 
212-480-3100 
www.nycpolicemuseum.org 
 
St. Paul’s Chapel 
209 Broadway 
212-233-4164 
www.saintpaulschapel.org

 
 
 

WONTAWK 
 

Outstanding Recruitment for Librarians & Other 
Information Professionals – Coast to Coast 

Permanent & Temporary 
Candidates Include Legal, Business & Finance Researchers 

Professional – ParaProfessional – Clerical 
Contact: Sarah Warner - Director of Staffing Services 

Phone-212/869-3348 - Fax-212/997-1127 
www.wontawk.com   wontawk@msn.com 

Call WONTAWK! 
Get the EDGE in Staffing and Consulting Services! 

 
 
 
 
 
 

www.renewnyc.org/Heritage
www.nps.gov/cacl
www.nycfiremuseum.org
www.financialhistory.org
www.nycpolicemuseum.org
www.americanindian.si.edu
www.saintpaulschapel.org


 ♦   

  

14

 

 
 

 

 

 
RESEARCH & RETRIEVAL 

WORLDWIDE 
LEGAL ~ FINANCIAL ~ GOVERNMENTAL ~ 

SCIENTIFIC 
 

  Client Comments: “I have a miracle retrieval service I 
use: Cal Info.” 
   “Not only did I get [the documents] yesterday…before 
my two hour 
    deadline [but you] called to make sure I was receiving 
them.”  
   “It seems like things arrive almost as soon as I get off 
the phone.”  

 
PUBLISHERS OF: CAL INFO GUIDE TO ADMINISTRATIVE 

REGULATIONS OF THE STATES & TERRITORIES, 13TH ED. 
 

4750 41ST Street, NW, Suite 5, 
Washington, DC 20016 

Phone:  202-537-8901   Fax:  202-537-
8902 

 
316 West Second Street, Suite 1102, Los 

Angeles, CA 90012 
Phone:  213-687-8710   Fax:  213-687-

8778 
www.calinfo.net 
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Bite the Bullet: The Elegant Triangle 
Victoria J. Szymczak, Brooklyn Law School 

 
In the previous issue of Law Lines, we focused on an approach to display bulleted items in a way that suspends the 
impression of a hierarchal list.  In this issue, we will avoid death by bullets by using the elegant isosceles triangle 
coupled with text boxes.  The slide will be further enhanced by using a simple animation.  This visual can be used to 
illustrate a process where the peak of the triangle is the goal; or the hierarchy of a department where the peak of the 
organization is the main person or department in charge.  
 
In my first example, typical components of a Civil Law system are introduced with the Constitution (under which 
all other laws function) sitting atop forms of authority.  To boost the impression that your discussion points 
represent a building process, I add a basic wipe animation to the slide.  Unfortunately, I cannot replicate the 
animation here; however, it is the fait accompli for this slide and you will not get the same effect without using it.  If 
you would like to download the “zipped” one slide Powerpoint file, you can click on 
http://www.brooklaw.edu/library/powerpoint1.zip, otherwise, please observe the static image posted below. 
 
Due to the limitations in the animation options of Corel Presentations (version 10), I am unable to replicate this 
effect using that software.  Of course, you can still use the idea of a triangle to convey a building process but it lacks 
that je ne sais quoi without the animation. 
 
The trick to building this type of graphic with the appropriate animation in your slide is to do a bit of color 
planning.  The background of your slide, the text, and the lines making up the graphic must all be the same color.  
Only the triangle itself is a different “fill” color.  Failure to follow the color plan will ruin the animation effect.  
Additionally, choosing the same color for your lines and background gives you a little wiggle room in your drawing 
skills.  It is best to use a plain color background without watermarks or other graphical makeup.1  In our example, I 
chose a dark blue background for the slide, lines, and text, and a plain white fill for the triangle.  Your end result 
should look something like this: 
 

 
 

                                                 
1 If you are using the slide in a larger presentation in which a background template was already applied and you want to 
maintain color coordination, you can omit any background graphics in PowerPoint by going to Format > Background, and 
then selecting “Omit Background Graphics from Master.”  If you click Apply, the graphics will be eliminated from only this 
one slide.  

http://www.brooklaw.edu/library/powerpoint1.zip
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To set yourself up for this graphic, first display a slide devoid of a content layout.  Select Format > Slide Layout > 
Content Layout Blank.  Then apply your background color to the slide by going to Format > Background.  In the 
pop-up window select your color from the pull down menu (in this example it would be blue).   
 
The elegance of a triangle derives from its symmetry.  In order to ensure your triangle conveys that feel of 
proportionality to your audience, it is important for you to center it on your slide.  A nice way to accomplish this is 
to use the ruler built into the software.  To display the ruler, select View > Ruler.  In order to follow the instructions 
here, it would also be useful to display your drawing toolbar by going to View > Toolbars and then checking on 
Drawing (if it already has a checkmark, it means that it is already displayed). 
 
With your ruler in place, draw an isosceles triangle using your drawing toolbar (Autoshapes > Basic Shapes > 
Isosceles Triangle).  Draw it from the top of the frame to the bottom.  Once it is drawn, position the top angle in 
the middle of the screen, and pull the drawing handles so that the two base angles are extended to the very end of 
bottom screen right and bottom screen left.  In other words, make it as big as you can.   
 
The last step in setting up the triangle is to choose a fill color and make the outline of the triangle the same color as 
the slide background (you can also select No line and achieve the same result).  Be sure to “select” the triangle so 
that it is the active shape on the screen (meaning the little squarish handles are controlling it). Both the fill color and 
line color are on your drawing toolbar (or you can right click on the triangle and select Format Autoshape).  In this 
example, I choose white as the fill color and a dark blue as my line color to match the background.   
 
The next step is to insert the dividing lines and text lettering using the same color that was used in the slide 
background.  To add the dividing lines, select Autoshapes > Basic Lines > Line from your drawing toolbar.  On the 
drawing toolbar you have the opportunity to change the color and thickness of the line.  Again, I chose the blue of 
my background (if my line drawing goes outside the triangle boundaries, it will not be visible since it is the same 
color as the background) and then selected a thickness of 2 ¼.  The placement of the lines is really a judgment call.  
If you use the ruler to make each division equal to the next, you will find that the bottom tier looks larger than the 
upper tier.  It is an optical illusion so I recommend just using the “good eye” method.  
 
To add text to your triangle, use the Text Box feature which is also on your drawing toolbar.  Draw your box in the 
area where you want your text to appear.  Before you actually type the text in the box, choose the font color from 
the drawing toolbar.  Also, select a font type and size that suits your presentation.  For example, if you are using 
Ariel in other slides, you might want to keep that same font type in your triangle.   Here I choose Blue, Ariel 
(Bolded), and font size 32.  Finally, when you finish typing the text, center it in the slide by using the center 
justification feature in your Formatting Toolbar.  Since your triangle is centered, your text will also appear centered 
in the triangle.  Do this for all the points you want to add.   
 
You took a lot of steps to get this far, but the real joy of using this type of slide is the animation.  In this example, I 
am trying to get across the point that all laws flow from the Constitution.  The animation I choose was a “WIPE” 
starting from the top and flowing downward.  If you wanted to convey more of a building process, you can also use 
a “WIPE” but have it flow from the bottom upward.  To add the WIPE, “select” the triangle so that the drawing 
handles are displayed.  Then, from the pull down menus on top select SlideShow > Custom Animation > Add 
Effect > Entrance > Wipe. 
 
In the animation pane, you will have the opportunity to change the direction, speed, and timing of the animation.  
You can experiment with the speed (I personally like a medium speed as the fast speeds hurt the eye and the slow 
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speeds are just too sluggish for my taste) and timing by checking off the Autopreview feature in the bottom of the 
animation pane.  By maintaining a common color between the background, text, and dividing lines, the text and 
lines appear to be part of the wipe effect, when in fact they are just blended into the background and only appear 
when the contrasting color of the triangle is introduced. 
 
A couple of hints and tips can make the triangle quite versatile.  In this second example, we see how we might fit 
unruly text in that small upper tier, and how to convey sub-issues within that tier or even outside of the main 
triangle.  In this triangle, we want to convey the idea that the most important part of a federal legislative history are 
the Reports – and the most important report of all is the Conference Report.  Also, notice on the sides of the main 
triangle, two smaller isosceles triangles in which is contained the types of government documents that may aid in 
interpretation of a statute, but are not necessarily considered part of a formal legislative history.  If you would like to 
download the “zipped” one slide Powerpoint to observe the animation effects, you can click on  
http://www.brooklaw.edu/library/powerpoint2.zip, otherwise, please observe the static image below. 
  

 
 
The base of the main triangle is narrower here than in the first example in order to accommodate the side issues: 
Committee Prints and Hearings.  Go through the same process as before in drawing your main triangle and color 
planning. When you get to the top of the triangle where we want to distinguish conference reports from other types, 
insert a dotted line rather than a solid line from your drawing tools or tool palette.  This conveys the idea that the 
Conference Reports are a little different.  Because the word “Conference” would not fit into that small space, I 
typed it into a “text box” off to the side and used a plain line to draw the reader’s eye from the center of the triangle 
off to that word.  The tricky thing here is that the word “Conference” and the line connecting it to the main triangle 
must be in a different color from the background and the rest of the text or else it will not be visible when the 
animation runs.  Choose an alternate color for that word and then turn toward your animation tools for a solution.  
It is extremely important to follow the suggested sequence and timing of the animation effect in order to create the 
right impression on your audience. 
 
Animate the main triangle as we did in the first example.  Then animate the line leading to the word conference.  In 
the animation window pane, change the timing of the line to appear “After previous.”  Then animate the text box 
containing the word “Conference.”  Change the timing on this animation to appear “With previous,” which mean at 
the same time as the line.  (continued on page 20) 
 
 

http://www.brooklaw.edu/library/powerpoint2.zip,
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The Evolution of an e-Business in Law 
David Merkin, Shearman & Sterling 

 
Law libraries have been going digital since the 
creation of Lexis in 1974. Lawyers have been 
venturing onto the Internet since the early 1990’s. 
Research once conducted by browsing through 
stacks is now accomplished on a desktop 
computer with a few keystrokes. True, research is 
easier than it used to be, but for librarians, the 
leaders of this change, it’s never been harder or 
more expensive. 
 More and more information resources are 
available electronically. In this exciting but 
uncertain environment, information providers 
who of course need to protect their investments 
are turning to licenses to define and control the 
use of their products. So in addition to following 
copyright laws, we must now manage the use of 
electronic information according to terms agreed 
to in a license. We must pay attention to details 
and effects of these agreements on our firms and 
users. 
 The chief role of the librarian has not 
changed; we provide information to our patrons. 
But today we do it across the globe with more 
information and tools at our disposal than ever 
before. We deal with vendors in creating access to 
all branch offices; in Shearman’s case, New York 
and all 18 Branches. And of course prices of 
content of electronic information continue to rise. 
 As we all know, license agreements are a fact 
of life when using electronic databases to access 
information. These providers of information use 
licenses to control use of their products. Some 
may restrict the rights of the users. 
Negotiating licensing agreements has become a 
complex task. Many librarians seek help from 
lawyers and financial officers at their firms  to help 
them better understand the legal language and 
make adjustment to various office budgets. 
 A lot of publishers may charge for their 
electronic services according to the number of 
attorneys or offices a firm has, whereas others may 
charge for 100 users even if you will only ever 
have 30 users, and still others may set prices for 
concurrent users. So seeking assistance from 
attorneys and financial officers helps librarians 

work out a better deal for their firm while still 
keeping the vendor happy. 
 When negotiating license agreements, define 
practice groups and offices that would use the 
product most, and keep in mind set budgets. 
When libraries first began to subscribe to 
electronic resources, license agreements were like 
all other small printed official sort of contract, 
non-negotiable and not understandable unless you 
were an attorney. Customer service representatives 
agreed to any license terms librarians wanted when 
they saw the interest in going electronic. For the 
past 10 years more libraries have been adding to 
electronic resources, causing license agreements to 
be more important. More libraries in New York 
are eliminating case reporters, state laws, and 
digests. 
Throughout the years the library director received 
and signed license agreements. Terms like “limited 
to four concurrent users” or “retained concurrent 
with a print subscription” , recently have appeared 
in more and more license agreements . It was 
never thought that there would be ways to see if a 
subscription was really being used according to the 
terms of an agreement . Quite often one now sees 
at the end of each agreement, “your subscription 
will be immediately suspended if payment is not 
received on time”. 
Managing and complying with the terms of a 
license has added to a librarian’s regular job duties. 
Once agreements have been signed which apply to 
the law firm and employees  who may never see or 
use the database, it’s up to the librarian to see that 
compliance with the terms takes place. Usually the 
librarian answers users’ questions about use or 
access. 
 A lot of librarians will refuse to accept a 
license if it has the term "not allowed to cancel 
print subscription" , if there is no clear definition 
of site or users, or if the library is to be held liable 
for attorney misuse of a subscription. 
 Librarians when giving ID’s to electronic 
sources will spend time  educating users on use, 
and contents of a firm license agreement. If 
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librarians know of violations to agreements they 
usually will cut off the violator’s database access. 
 Agreements all let one retrieve display and 
print individual pages, even store pages on a disk, 
but not on any server or other storage device 
connected to a network. 
 Copyright law is restated in license 
agreements, mentioning permission from the 
information provider is needed before 
redistributing, and all agreements do not allow you 
to remove the copyright or trademark notice or 
create a database of articles downloaded off a 
particular website. 
 However, sites that post news articles allow 
you to print and download as long as at the 
bottom of each article you state "used with 
permission" and the name of the provider. 
Copying or downloading is used frequently when 
the person claims fair use  for educational, 
scholarly purposes or for use in a newspaper 
article. Digital copies have the same copyright 
protection as printed materials. The Digital 

Millenium Copyright Act updates the 1976 
Copyright Law for electronic use. 
 Many online users have the mistaken idea 
that any work available online can be freely copied 
and distributed without permission. Copyright 
laws have stopped large publishers and 
information providers from stealing from smaller 
ones. 
It is not hard to see what is coming: if libraries 
want to download print, or forward articles or 
papers or books, all must be negotiated and appear 
in a license agreement. A large amount of future 
acquisitions may be online to accommodate all 
offices of a firm. So all contracts and agreements 
have to be carefully studied before being signed 
and shown to our patrons. These have now 
become a fact of life in conducting business in the 
electronic environment. Negotiating and 
understanding license agreements is the new 
frontier for law librarians. 

 

 
_____________________________________________________________________________ 
Szymczak, continued from page 17 
 
Draw the side triangles as you would the main triangle.  You will NOT be able to draw it on its side as it appears 
here.  Once the triangle is drawn you will need to use your drawing tools to rotate it.  With the triangle selected, go 
to Draw > Rotate or Flip > Free Rotate.  You will now see a green handle on the triangle.  If you grab that green 
handle you will be able to rotate the drawing into a position that you want.  Do this for both triangles.  Insert the 
text boxes into those triangles.  Again, you will not be able to write them on a slant as you see here.  Use the “Free 
Rotate” feature in the drawing toolbar on the text box so that you can fit it into the triangle nicely. 

 

One final step requires you to animate these side triangles.  Visit your custom animation tools again (remember, 
SlideShow > Custom Animation > Effects > Entrance > Wipe).  Change the timing on the first triangle to be either 
“After previous,” meaning, after the word “ Conference” appears or “On Click” if you want to retain control over 
when it appears.  Change the timing on the second triangle to “With previous,” meaning at the same time as the 
first side triangle, or On Click. 
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An Educational Wish List From the Private Sector 
Craig Eastland, Fried Frank Harris Shriver & Jacobson LLP 

 
As someone who hires reference librarians for a 
private law library, I feel compelled to state the 
following opinion:  library schools are failing aspiring 
private sector librarians.  Although private law firm 
libraries are a major employer of librarians, training 
for reference librarians headed to private law firm 
practice is, at best, token.  Library schools turn out 
law librarians who can’t do reference without several 
months of on-the-job training.  As a result, those of 
us who hire law librarians aren’t able to hire recent 
graduates because we’re too busy and we don’t have 
months to commit to training. 
 
Therefore, I have two requests to make to library 
schools with law specialization.  My quick survey of 
the website of the Conference of Law Library 
Educators turned up many library schools whose 
specialization in law librarianship consists entirely of a 
class called “Law Librarianship.”  Overview legal 
research classes do nothing to prepare one for the 
level of specialized knowledge needed for law library 
reference.  The AALL website concurs about the 
relative uselessness of one general law librarianship 
class:  “ While a graduate program that offers only 
one course in law librarianship does not give you an 
in depth exposure to law librarianship, you may be 
able to supplement the course with independent 
studies, [or] internships for academic credit”. 
 
I think, however, that the argument that one class is 
not enough misses the point.  One class is enough if it 
is the right class.  For example, a course in “Library 
Bibliography” would do nothing to make a resume 
more attractive to me.  On the other hand, my beady 
eyes would light up if I saw that someone had taken a 
course called “IP Research and Sources.”   This is not 
a request to teach a class for every area of the law – 
this is a request for library schools to be responsive to 

their communities. In New York City, where I work, 
and where a number of library schools are based, one 
needs to know a lot about the securities laws, the 
corporation law of the state of Delaware, and the law 
of the state of New York.  Knowing that the SEC is 
part of the executive branch won’t do you any good 
when a partner calls, growls “Get me Reg. 13D,” and 
then hangs up.  That’s request number one – know 
the legal market in your community and create classes 
that make your graduates attractive to that 
community. 
 
Request number two, teach the law.  Knowing 
something about the law can make a significant 
difference in a reference interview.  This is especially 
true when dealing with a new associate who (1) 
doesn’t know that much about the law, (2) is afraid to 
ask the partner follow-up questions, and (3) hasn’t 
thought the legal issues through before showing up in 
your guest chair.  I’ve found that many new associates 
freeze up a bit and need a push to start doing the legal 
analysis.  I’m not saying that one must be a lawyer to 
do an effective reference interview, but having a 
working knowledge of the structure of the law helps.  
Perhaps the strongest argument for teaching the law 
to law librarians is that the law is too complex and too 
conceptual to just be picked up on the job.  It would 
be difficult, for example, to absorb the legal 
distinction between corporate officers and corporate 
directors piecemeal, but the law could be explained in 
just a few minutes.  Knowing the difference would 
make for a faster and more productive reference 
interview. 
 
So, that’s what I’d like to see:  law librarian education 
that is practical because it teaches research as it is 
done in the real world, and responsive because it 
reflects the needs of the professional community.
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LLAGNY Government Documents Seminar 
 

      
On April 7th, LLAGNY sponsored “Online Access to Government Information: Getting Government Documents 
to your Desktop” a breakfast seminar held at Fordham Law School.  Jane A. Cramer, Government & Legal 
Information Librarian at Brooklyn College Library and Michael H. Roffer, Government Resources & Reference 
Librarian at New York Law School presented us with a wide array of free government websites to help us find 
everything from federal judge biographies to customizable, downloadable statistical data from the Bureau of Labor 
Statistics and other federal agencies.  Jane & Michael also composed an amazing bibliography of online federal 
government resources that should be available on the LLAGNY website soon. 
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SLA Copyright Seminar, March 23, 2005 
@ Skadden Arps 

Photos by David Merkin, Shearman & Sterling 
 

        
    Tucker McGrady, IP Attorney   Gwen Loeffler, SLA President 
    Shearman & Sterling 

      
    Dave Oakley, LexisNexis   Laura Gasaway, Director of the Law Library 
          UNC Chapel Hill 

 
 



 ♦   

  

24

 

LLAGNY BOARD MEETING 
 January 19, 2005 

Hughes Hubbard & Reed LLP 
New York, NY 10004-1482 

 
Members Present:  David Merkin (presiding), Patricia 
Barbone, June Berger, Heidi Bliss, Anthony Cocuzzi, 
Karen Heusel, Patricia Kasting, Janet Peros, Andrew 
Tschinkel, Mark Zaleck. 
 
Board Meeting called to order:  6:12 PM 
 
Approval of December 2004 minutes: 

 Motion to approve minutes 
 Motion approved (Bliss, Berger) 

 
Old Business: 

 LLAGNY website:  Board request some technical 
modifications, changes in the design layout, and 
editing of content.  Members Only part of the site 
should contain the LLAGNY directory, the job 
hotline and Law Lines. 

 LLAGNY stationery:  Colors and amount to order 
discussed. 

 Nominations:  The President recommends a 
candidate for chair of the Nominations 
committee.   

o Motion to approve the President’s 
candidate if the candidate agrees to serve 
as chair. 

o Motion approved (Bliss, Barbone) 
 

 Union List:  The vendors request sample records 
to use for the demonstrations. 

 
New Business: 

 Discussed request from Brooklyn Legal Services 
to recommend a law librarian to volunteer for a 
project. 

 LLAGNY/SLA Copyright program:  Discussed 
scheduling. 

 
Committee Reports: 
 

 Advertising Committee:  One of the co-chairs of 
this committee resigned and the President (David) 
is seeking a new co-chair. 

 

 Corporate Sponsorship:  West has some additional 
funds to offer the Education committee.  
Corporate Sponsorship is working to cultivate 
relationships with new vendors. 

 Education Committee:  Submits a proposal for a 
program “Finding U.S. and Foreign Treaties in 
English”. 
Discussed attendance fee, and the Board 

recommends a sponsor and no fee. 
o Motion to approve proposal and budget 

as submitted. 
o Motion approved (Bliss, Barbone) 

 MCLE/ Teaching Legal Research Committee 
Program confirmed for Friday, April 15th from 
10:00am to 3:00pm at Columbia Law School.   
The committee submitted proposal to seek 
sponsorship for the Bridge the Gap program from 
law firms.  Board denied the proposal for this 
year, but request that the idea be more fully 
developed and resubmitted during the Fall of 
2005. 
 Grants & Scholarships Committee:  AALL 

will underwrite one free registration to the 
AALL Annual Meeting.  Name must be given 
to AALL by May 1, 2005. 

o Task:  Committee will treat and 
present this as another grant. 

 Special Events Committee:  Investigating a 
cruise line for the location of the June Dinner. 
The Manhattan Club as the location for the 
Annual Winter Meeting & Post Holiday Party 
was very successful.  If can secure as site for 
next year’s Annual Winter Meeting should be 
able to charge members less to attend.   
Modify name of event to Annual Winter 
Meeting. 

 
Meeting Adjourned: 8:20 PM 
Respectfully Submitted 
Patricia Kasting 
Secretary LLAGNY 
 

LLAGNY BOARD MEETING 
February 16, 2005 

Milberg Weiss Bershad & Schulman, LLP 
New York, NY 10119 
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Members Present:  David Merkin (presiding), Patricia 
Barbone, Heidi Bliss, Anthony Cocuzzi, Karen Heusel, 
Patricia Kasting, Janet Peros, Mark Zaleck 
 
Board Meeting called to order:  6:10 PM 
 
Approval of January 2005 minutes: 

 Motion to approve minutes 
 Motion approved (Barbone, Bliss) 

 
Treasurer’s Report: 

 Our total expenses were $5,000 
 Our total income is $2,709.41 

 
Old Business: 

 Stationery:  Approved the use of one color for 
logo on envelopes.  Placing of address on 
stationery needs to be decided. 

 June Dinner:  Do not hire a band.  Approve 
providing bus transportation to and from the 
cruise line.  Logistics of transportation will need to 
be determined. 

 
 AALL Action Alert: 

o Motion to approve AALL Action Alert 
letter submitted by Government Relations 
Committee: 

o Motion approved (Bliss, Barbone) 
 
Nominations Committee: 

 Motion to confirm Christina Rattiner as chair of 
the Nominations Committee. 

 Motion Approved (Bliss, Barbone) 
 
New York Technical Services Librarians reception: 

 Motion to co-sponsor evening reception with the 
New York Technical Services Librarians on 
Friday, March 18, 2005. 

 Motion approved (Barbone, Heusel) 
 
Committee Reports: 

 Corporate Sponsorship Committee:  Is confirming 
vendor commitments for the June Dinner. 

 Education Committee: 
o Motion to approve Quantum program 

Measuring Impact: Cost Justification for 
Information Services as submitted. 

o Motion approved (Barbone, Bliss) 

o Committee proposes an effective negotiation 
skills program, but is having difficulty 
securing a location for an evening program. 

 Law Lines:  Always need more contributions from 
the LLAGNY membership:  articles, pictures or 
both.  Next issue – Spring 2005 – expected by mid 
to late April. 

 MCLE / Teaching Legal Research Committee:  
Presenters materials are to be submitted by March 
1, 2005.  Prefer not to charge a fee and are seeking 
a sponsor.  Flyers announcing program needs to 
be approved.  Discussion with co-chairs is 
requested. 

 Membership Committee:  The Directory has been 
sent to the printer and should be mailed any day. 

 Student Relations Committee:  They are working 
on the student event.  Board recommends that the 
event be kept as a breakfast. 

 Technology Committee:  Requests that Board 
prioritize suggested changes to website.  Requires 
discussion so tabled until next meeting. 

 Union List Committee:  SIMA offers to present a 
demonstration in New York City. 

 Volunteers Committee:  Reserve a table for 
LLAGNY at the AALL Annual Meeting.  Suggest 
bag clip/sealers be provided as handouts. 

 Require gifts to present to volunteers at the June 
Dinner. 

 Online volunteer form should provide links to 
committees and emails to members of the 
volunteer committee. 

 
Meeting Adjourned:  8:05 PM 
Respectfully Submitted 
Patricia Kasting 
 

LLAGNY BOARD CONFERENCE CALL 
Friday, February 18, 2005 

12 Noon 
 

Members Present:  Heidi Bliss (presiding), Patricia 
Barbone, June Berger, Anthony Cocuzzi, Karen Heusel, 
Patricia Kasting, Janet Peros. 
 
MCLE/Teaching Legal Research co-chairs - Jeff Cohan 
and Sarah Valentine – were not available for the call. 

 Motion that if a sponsor if secured for the Bridge 
the Gap program and donates $1,000.00 or more 
that the fee charged be $25.00, but if less than 
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$1,000.00 or no sponsor the fee charged by 
$30.00. 

 Motion approved (Berger, Barbone) 
 Motion that flyer be approved pending 

recommended changes, and revisions reviewed by 
Secretary. 

 Motion approved (Barbone, Heusel) 
 
Education Committee: 

 Motion that Government Documents program be 
approved as submitted, with a cost of no more 
than $400.00 and postage, and revisions of flyer.  

 Motion Approved (Barbone, Bliss) 
 
Conference Call meeting adjourned:  12:22 PM 
Respectfully Submitted 
Patricia Kasting 
 

LLAGNY BOARD MEETING 
March 16, 2005 

Shearman & Sterling  
New York, NY 10022 

 
Members Present:  David Merkin (presiding), June Berger, 
Heidi Bliss, Anthony Cocuzzi, Patricia Kasting, Janet 
Peros, Andrew Tschinkel, Mark Zaleck 
 
Board Meeting Called to Order:  6:10 PM 
 
Approval of February 2005 minutes: 

 Motion to Approve Minutes 
 Motion Approved (Bliss, Berger) 

 
Treasurer’s Report:  Treasurer was not present 
Old Business: 

 Stationery:  Discussed layout of letterhead 
stationery 

o Motion to Approve letterhead layout as 
modified. 

o Motion Approved (Berger, Zaleck) 
 LawLines:  Access to LawLines on website 

 Current  issues and archives are open to the public 
 Remove ads from archived issues and give notice 

of removal 
 
New Business: 

 Catherine Lehmann – Secretary of AALL Board – 
is the guest speaker for the June Dinner 2005. 

 Propose speech topics 
 Corrections to the LLAGNY Directory 
 SLA Career Day is April 1st and it is 

recommended that law librarians attend. 
 LLAGNY Table at AALL: will handout 

LLAGNY package clips. 
 Gift for volunteers, committee members and 

board 
 
Committee Reports: 

 LawLines:  email to membership procedure for 
submission of articles and a call for articles. 

 Provide print copies of last 2 issues for the 
LLAGNY table at AALL Annual Meeting. 

 MCLE/Teaching Legal Research Committee:  
notice of the program has gone out to students 
and law school, law firm and court administrative 
contacts.  Registrations are starting to be received. 

 Public Relations Committee:  reviewed brochure 
and letter to new members 

 Special Events Committee:  Need to confirm 
sponsors with Corporate sponsorship. 

 Student Relations Committee:  Reviewed flyers 
and proposed some changes 

 Recommend Helen Lawless as speaker for 
breakfast 

 Breakfast is open to members as well as students 
 Union List Committee:  arrange date for 

demonstration of EOS.   
 
Meeting Adjourned:  8 PM 
Respectfully Submitted 
Patricia Kasting 
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Serving NY, NJ, & CT since 1977 

Sofia Empel, MLS                                                                                        Lucy Rieger, MLS 

Our services include: 
 

o Looseleaf Filing/ Maintenance 
o Archive/ Document Management 
o Space Planning/ Moving 
o Permanent or Temporary 

 
332 Terrace Avenue, Hasbrouck Heights, New Jersey 07604 

 
   (201) 288-5883 *Luiny@Libraryupdate.com * FAX (201) 288-7976     

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VOLUNTEER FORM 
 

 
 

LLAGNY JOB POSTINGS 
 

Advertise your current job postings on the LLAGNY website. 
 

http://www.aallnet.org/chapter/llagny/jobs.html 
 

Rates are $50 for two weeks, $75 for four weeks.  Check should be made payable to 
LLAGNY.  Send job descriptions to Denis O’Conner via email or fax.  Please include your 
name, address and telephone number for billing purposes.  Job descriptions received by 

Thursday at 4pm are normally posted on this Web page the following Monday. 
 

Denis O’Conner 
Debevoise & Plimpton 

919 Third Avenue 
New York, NY  10022 

Fax: 212-909-1025 
droconner@debevoise.com 
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VOLUNTEER FORM 

 
 The success of LLAGNY is dependent on the voluntary efforts of its members.  By joining a committee, 
you have the opportunity to interact with your colleagues, make a contribution to your professional association 
and see the results of your efforts. 
 
 This is the chance to build on old experiences and contribute your expertise and background.  The more 
people who come forward, the more the work is shared. 
 
 Below is a list of committees which cover a wide range of functions and activities.  Please click on the 
committee name for a detailed description of each.  Please feel free to contact the committee co-chairs for any 
questions on their specific committee. 
 
Advertising | Corp. Sponsorship | Education | Govt. Relations | Grants/Scholarships.  
Job Hotline | Law Lines | MCLE | Membership | Nominations  
Placement | Pro Bono | Public Relations | Special Events  
Student Relations | Technology | Union List | Volunteers 
 

Name:_______________________________________________________ 
 
Title:________________________________________________________ 
 
Affiliation:____________________________________________________ 
 
Phone:________________________ Email:__________________________ 
 
1st choice_____________________ 
2nd choice_____________________ 
3rd choice_____________________ 
 
________Please assign me to any committee    

 
Please  email your completed form to the Membership Committee John Davey Co-Chair daveyj@sullcrom.com 

or Brooke Raymond braymond@goodwinprocter.com 

http://www.aallnet.org/chapter/llagny/Advertising.html
http://www.aallnet.org/chapter/llagny/CorpSponsorship.html
http://www.aallnet.org/chapter/llagny/Education.html
http://www.aallnet.org/chapter/llagny/GovtRelations.html
http://www.aallnet.org/chapter/llagny/GrantsScholarships.html
http://www.aallnet.org/chapter/llagny/LawLinesComm.html
http://www.aallnet.org/chapter/llagny/MCLE.html
http://www.aallnet.org/chapter/llagny/Membership.html
http://www.aallnet.org/chapter/llagny/Nominations.html
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